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1

Description
Otosuite Reports is a software tool for creating report templates to be used for generating reports from Otosuite/Otobase.
The reports can be set up to display patient data, tests results, and user information.

1.1

Software integration
Otosuite Reports integrates with:
•

Otosuite
Otosuite is a software tool for performing, viewing and reporting audiological test results.

•

Otobase
Otobase is a software tool for managing clients and storing and transferring audiological test results.

Otosuite and Otobase are products from Otometrics.

1.2

The scope of this manual
This manual describes the general functions of Otosuite Reports. For help relating to Otosuite, see the Otosuite User
Guide, the Otosuite Reference Manual, and the Otosuite online Help. For help relating to Otobase, see the Otobase User
Guide and the Otobase Reference Manual.

1.3

Typographical conventions
The use of Warning, Caution and Note
To draw your attention to information regarding safe and appropriate use of the device or software, the manual uses precautionary statements as follows:

Warning • Indicates that there is a risk of death or serious injury to the user or patient.

Caution • Indicates that there is a risk of injury to the user or patient or risk of damage to data or the device.

Note • Indicates that you should take special notice.

2

Intended use
Users: Any person assigned with the task of designing or editing report templates for use with Otosuite or Otobase.
Use: Designing or editing report templates for use with Otosuite or Otobase.
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Installation
For instructions on installing Otosuite Reports, see the Otosuite Installation Guide.
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Launching Otosuite Reports
To launch Otosuite Reports:
•

Double-click on the Otosuite Reports icon on your desktop. You may need to create
the shortcut first.

or
•
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Select Start > All Programs > Otometrics > Otosuite® Reports.

Navigating in Otosuite Reports
Menu bar
Toolbar
Report elements pane
Report page
Create next page in template
F. Clear contents on page
G. Elements formatting pane
H. Scaling bar and icons for scaling the view
A.
B.
C.
D.
E.

A. Menu bar
Click File to

Otosuite Reports

•

access the Otosuite file management functions

•

select language.
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B. Toolbar
The toolbar is divided into a number of main sections. Editing, arranging and layout functions are general functions commonly used in Microsoft Office software. If desired, you can right-click the elements in the toolbar to customize their
location in ribbons.

Edit

Undo/redo the latest action(s).

File

The main functions, which are also accessible from the File menu:
•

Loading data for assessing the report design ► 8

•

Designing a report template ► 7

•

Saving a report template ► 12

•

Printing test results from Otosuite or Otobase ► 13

•

Saving a report template to PDF ► 12

Arrange

Functions for aligning and layering report elements.

Report

Functions for setting up the main page layout and defining whether client ID and
personal data should be included in the report.
•

Defining the page setup ► 8

•

Defining the report header and footer ► 8

•

Printing an anonymous report ► 13

About
Displays the Otosuite Reports version and manufacturer details.

Help
Click to launch the help file or press F1 on the keyboard.

C. Report elements pane
From the report elements pane you can select the elements you wish to include in the report, such as session, examiner, client details, and desired measurements and test results. See also Designing a report template ► 7.
It is easier to design a template and place elements with data loaded, as some elements may take up considerable
space. Expandable elements are identified by icons denoting how the element expands. The icons are described in
Inserting report elements in the report ► 10.

D. Report page
The report page represents one or more pages in the report you wish to create. This is where you define the layout of
the report and place the report elements in a sequence of your choice.
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E. Create next page in template
Click this icon to create the next page in the template. Expandable elements
placed in a flow area will automatically expand to a page following the created
page.

F. Clear contents on page
Click this icon to clear the contents on the page, or to delete the entire page.
•

If you are working with a single page report, the entire page is deleted,
including header and footer.

•

If you are working with a multi-page report, only the page shown is deleted.
Header and footer are not deleted.

G. Elements formatting pane
From the elements formatting pane you can select the format of the elements you wish to include in the report.
See Inserting report elements in the report ► 10.

H. Resize page
Use the scaling bar or click these icons to resize your view of the page.
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Designing a report template
You can design a report template either by copying an existing report template and customizing it to your needs, or by creating a template by adding report elements to the blank page.
When you design a report, there are a number of steps we recommend that you consider:

Creating a new report template
•

To create a new report template, click New.

•

Create a new report template or open an existing report.

Opening an existing report template
In Otosuite and Otobase you can select where the programs will look for report templates. By default the factory defined
templates are placed in ..\Program Files (x86)\GN Otometrics\OTOsuite\Reporting\xx (xx = language) and user defined templates are found in ..\ProgramData\GN Otometrics\Shared\Reports.
•

To open an existing report template, click Open and select the report template you wish to open.

Designing the report template
•

Otosuite Reports

Loading data for assessing the report design ► 8
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•

Defining the page setup ► 8

•

Defining the report header and footer ► 8

•

Using flow areas ► 9

•

Inserting report elements in the report ► 10

•

Inserting a PDF file in the report ► 11

•

Inserting images in the report ► 11

•

Previewing the report template ► 11

•

Saving a report template ► 12

•

Saving a report template to PDF ► 12

Copying a report template to another PC
•

6.1

Copying a report template to a PC with Otosuite or Otobase installed ► 12

Loading data for assessing the report design
Otosuite Reports is delivered with a set of data for demonstration purposes so that you can assess the size and functions of
the report elements when they are placed on a report page.
If you load data, the elements in the report elements pane will be populated with test data for the currently selected session, where available.
You may find it easier to select and place elements with data loaded, because some elements may take up considerable
space. Expandable elements are identified by symbols denoting how the element expands. See Inserting report elements
in the report ► 10.
When you drag an element onto the page, it will be shown fully populated.

Otosuite Reports launched from Windows
If you launch Otosuite Reports individually, you can load data manually:
1. In Otosuite Reports, click Load Data.
2. If Otosuite or Otobase has been installed in the default folder, the data files are located in the Windows folder...\Documents\My Suite.

6.2

Defining the page setup
Select Page Setup in the toolbar to select the paper size and page margins you wish to use for the report.

Note • The default paper size is A4. Make sure that you select the desired paper format before you start designing the
template, so that there is enough space for the various elements.

6.3

Defining the report header and footer
Showing header and footer on all pages (for multi-page reports)
1. Click Header/Footer in the toolbar to activate the header and footer. If you have placed elements on the report page,
they will be grayed out to indicate that you are working in the header/footer area.
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2. When you place one or more elements in the header or footer area, the elements will be shown on all pages in the
report.

Note • Make sure that expandable elements do not overlap header elements: Define the paper margins so that the
header elements are outside the margins.

Hiding the header and footer on the first page
If needed, you can choose to hide the header and footer on the first page of the report.
1. Disable the selection Show header/footer on first page in the Page Setup dialog.

6.4

Using flow areas
A flow area is an expandable area you can place on a report page so that all parts of an expandable element are shown in a
continuous flow.
If a flow area cannot contain the element, then the element will be placed in the next flow area.
If there is not enough space in the flow area for all the elements, one or more extra pages will be added with full page
flow areas.
1. From the Basic section in the report elements pane, select Flow Area and place it on the report page.
2. If needed, scale the flow area to the desired width.

Placing elements in a flow area
When you place an element in a flow area, make sure that the handle in the top left corner of the element is within the
flow area. This will ensure that the element is locked to the flow area.

Changing the order of elements
You can change the order of the elements shown in the flow area:
•

Click the icons in the toolbar or right-click the element and select from the options Bring to Front, Bring Forward,
Send to Back, Send Backward.

Example 1 - Dynamic tables in a flow area
If you place a dynamic element in a flow area and place a normal element below it in the same flow area, the normal element will follow the dynamic element regardless of the size of the dynamic element.

Example 2 - Templates with many elements
If you are designing a template with many elements, e.g. with audiograms, speech table, and tympanometric tables, where
data is available only for some of them, you can define the element or elements as Show only if content is available, and
place all of the elements in one single flow area.
The report will only show the elements where data is available. Empty elements with no data available will be hidden and
the flow area will shrink to fit the elements that are showing data. This means that you can make the report print on e.g.
only two pages, if the performed measurements require this.

Example 3 - Using more than one flow area
If you have designed a template so that some elements must have a fixed position in the template, you can create two or
more flow areas. When the elements in these flow areas are populated with data, they will be pushed into the next flow
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area with space available for it, without overlapping or shifting fixed elements.

6.5

Inserting report elements in the report
From the report elements pane you can select the elements you wish to include in the report, such as session, examiner,
client details, and desired measurement and test results.
1. In the report elements pane, click to open the groups of elements you wish to use.
2. Drag and drop the desired element onto the report page.
3. If needed, scale the element to the desired size.

Formatting elements
1. If needed, right-click on the element and select Format Element. In the formatting pane you can format
the element to show the features you need, such as Left Ear audiogram or Right Ear audiogram.
2. Some format settings shown in the formatting pane are marked with a lightning symbol, which means
that the setting will be overwritten by the equivalent setting in Otosuite or Otobase, if you print
from Otosuite or Otobase with the print selection Print using Otosuite settings or Print using Otobase
settings enabled.
If you wish to retain the new format, deselect this function in Otosuite or Otobase.

Expandable elements

Note • Make sure that expandable elements do not overlap header elements: Define the paper margins so that the
header elements are outside the margins.

When you place a report element in the report template, it is important to consider whether the element will expand
when it shows numerous results. To accommodate this, some report elements are expandable. In Otosuite Reports, this is
shown as a small icon next to the top right corner of the element when you have placed it on the report page. The icon
will not be shown on the printed report.

Icons denoting expandable elements
Invisible if no data is available.
More rows will be added automatically, if needed.

More tables will be added automatically, if needed. This type of element cannot be placed in a flow area.

If you are using expandable elements, we recommend that you place them in a flow area. This will ensure that they do not
expand over other elements or over the bottom of the page. See Using flow areas ► 9.
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The Comments Field element
The amount of comments can vary a lot from patient to patient. To accomodate this, the Comments Field element can
divide the comments in two parts in the report.
The first part of the comments is always shown where the Comments Field is placed when the report is designed.
In cases where all of the comments do not fit into the original Comments Field area, check the checkbox Show Tail Element. An additional Comments Field element will be placed automatically at the end of the report. This additional field
will contain the entire comment.

6.6

Inserting a PDF file in the report
You can insert one or more PDF files in the report.
To do so:
1. Open the Basic element group and drag PDF Element onto the page.
2. You will be prompted to browse to the file you wish to use.
3. Select the file.
This means that the PDF file will be inserted as a link. If a test system, such as Otosuite Vestibular, is set up to overwrite this file when it updates with the latest report, then this latest report will be added to reports generated with
this template.

6.7

Inserting images in the report
Images are often used to represent the company or institution responsible for generating the report. You can insert images
or logos, for instance in the header of the report by using a graphics file of your choice.
To do so:
1. Open the Basic element group and drag the Image element onto the page.
2. You will be prompted to browse to the file you wish to use.
3. Select the image and scale it to the desired size.

Linking to an image file
You can insert the image as a link. If you do so, you can change the logo used in the report templates by changing the
image file.
1. Open the Basic element group and drag the Image element onto the page.
2. You will be prompted to browse to the file you wish to use.
In the browser dialog, use the drop-down menu to select Insert & Link or Link.
3. If you wish to reuse the generic graphic that is used in existing default reports, you must link to the file:
...\Program Files (x86)\GN Otometrics\OTOsuite\Reporting\Misc\Company-Logo-1200x331-px

6.8

Previewing the report template
You can view the report template as a print preview to ensure that the report design appears as intended.

Otosuite Reports
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Caution • Make sure that the report elements are correct, for instance that an audiogram which has been formatted
to show left ear results actually does so.

1. To preview a report template, click Print Preview in the toolbar.
2. You can preview all pages in the report template, and print out the template.

6.9

Saving a report template
If the default setting of Otosuite or Otobase has not been changed, they will use the report template files placed in the following folders:
•

Factory defined templates:
..\Program Files (x86)\GN Otometrics\OTOsuite\Reporting\xx (xx = language)

•

User defined templates:
..\ProgramData\GN Otometrics\Shared\Reports

Note • The ProgramData folder is a hidden Windows folder. If needed, open the Windows Control Panel and select
Folder Options > View, and in the Advanced Settings part, enable Show hidden files, folders and drives.

Adding title and description to the file name
If you save a template under a new name, in addition to the file name you should also enter a title and a description.
Entering a title is important, because the title will be shown in Otosuite and Otobase, e.g. in the Report Manager dialog.

6.10

Saving a report template to PDF
If you wish to save the report template as a PDF file, click the Save to PDF icon in the toolbar.

6.11

Copying a report template to a PC with Otosuite or Otobase installed
If you have designed report templates on a PC without Otosuite or Otobase installed, you must copy the report templates
to the PC with Otosuite or Otobase.
In a default installation, the report templates are located in the PC's Program Files folder.
If Otosuite or Otobase has been installed in their default folder, save the report templates as follows:
•

Factory defined templates are placed in ..\Program Files (x86)\GN Otometrics\OTOsuite\Reporting\xx (xx = language)

•

User defined templates are placed in ..\ProgramData\GN Otometrics\Shared\Reports

Note • The ProgramData folder is a hidden Windows folder. If needed, open the Windows Control Panel and select
Folder Options > View, and in the Advanced Settings part, enable Show hidden files, folders and drives.
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Printing test results from Otosuite or Otobase
You can print results as reports from Otosuite or Otobase.

Note • Always print your reports directly from Otosuite or Otobase. Otosuite reports are not available through the
Noah print function.

You can choose between a number of predefined reports in Otosuite.
The reports show the data currently available for a specific client, and may show data from more than one session.
Some of the reports show a combination of measurements from different modules.
For most standard created reports, the following applies: If the report shows data from measurements done at an earlier
date, the date when the measurement was made will be displayed next to the measurement title.

7.1

Printing an anonymous report
If you wish to print a report showing only measurements, without showing the client name or personal data,
click the Anonymous icon.
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Warning notes
This Guide contains information and warnings, which must be followed to ensure the safe use of Otosuite. Local government rules and regulations, if applicable, should also be followed at all times.
When Otosuite is used in conjunction with a test device, make sure that all information and warnings in the manual for the
test device are followed.
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Definition of symbols
Used in error message dialogs if software program fails. See the detailed information in the dialog box.

CE marking of conformity
Certification mark that indicates conformity with applicable regulations and directives for the European Economic Area.
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Other references
For more information, see the online Help in Otosuite, which contains detailed reference information about Otosuite and
the test devices that can be used with Otosuite.
After you install Otosuite, you can find Otosuite manuals and related documentation on your PC. In the Start menu, open
Otosuite Manuals, which contains an overview with links to all manuals.
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Manufacturer
Natus Medical Denmark ApS
Hoerskaetten 9, 2630 Taastrup
Denmark
+45 45 75 55 55
www.natus.com

11.1

Responsibility of the manufacturer
The manufacturer is to be considered responsible for effects on safety, reliability, and performance of the equipment only
if:
•

All assembly operations, extensions, re-adjustments, modifications or repairs are carried out by the equipment manufacturer or personnel authorized by the manufacturer.

•

The electrical installation to which the equipment is connected complies with EN/IEC requirements.

•

The equipment is used in accordance with the instructions for use.

The manufacturer reserves the right to disclaim all responsibility for the operating safety, reliability and performance of
equipment serviced or repaired by other parties.
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